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1 はじめに

「ASCET 製品ファミリ」は、組み込みソフトウェアシステムのファンクション開
発とソフトウェア開発のための革新的なソリューションを提供するものです。各
ASCET 製品は、新しい独自のアプローチによって、モデリング、コード生成、シ
ミュレーション実験、といった開発工程の各段階を強力にサポートするので、品
質向上や開発サイクルの短縮、さらにコスト低減を実現できます。

本書は、ASCET 製品のインストール方法、およびそれに関連する情報を説明する
ものです。製品の機能や操作方法などについての情報は、各製品のマニュアルや
オンラインヘルプをご参照ください。

1.1 本書について

1.1.1 本書の構成

ASCET インストールガイドは、以下の章で構成されています。

• 「はじめに」（本章）

本書に関する一般的な説明です。

• 「プログラムのインストール」

この章は、PC またはネットワーク上に ASCET をインストールし、ASCET
プログラムのメンテナンスやアンインストールを行うすべてのユーザー、
および ASCET をファイルサーバーに供給してネットワーク経由のインス
トールを行うシステム管理者を対象としています。ここには、製品の内
容、スタンドアロンインスタレーションとネットワークインスタレーショ
ンに必要なハードウェアやソフトウェアの要件、インストールの準備作
業、インストールとアンインストールの手順も紹介されています。

• 「ライセンスについて」

ASCET を使用するためのライセンスについての情報（ライセンスファイ
ルの入手方法、ライセンスの借用方法など）が説明されています。

• 「お問い合わせ先」

ETAS の各支社の連絡先です。

1.1.2 本書の使用法

表現について

ユーザーが実行するすべてのアクションは、いわゆる“Use-Case”形式で記述さ
れています。つまり以下に示すように、操作を行う目標がタイトルとして最初に
簡潔に定義され（例：「新しいコンポーネントを作成する」、「エレメントの名前を
変更する」）、その下に、その目標を実現するために必要な操作手順が列挙され、
必要に応じて ASCET のウィンドウやダイアログボックスのスクリーンショットが
添付されています。
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目標の定義：

前置き ...

• 手順 1

手順 1 についての説明 ...

• 手順 2

手順 2 についての説明 ...

• 手順 3

手順 3 についての説明 ...

まとめ ...

具体例：

新しいファイルを作成する：

新しいファイルを作成する際は、他のファイルをすべて閉じておきます。

• File → New を選択します。

“Create file”ダイアログボックスが開きます。

• 新しいファイルの名前を、“File name”フィール
ドに入力します。

ファイル名は 8 文字以内でなければなりません。

• OK をクリックします。

新しいファイルが作成され、ユーザーが指定した名前で保存されます。このファ
イルを使用して以降の操作を行います。

表記上の規則

本書は以下の規則に従って表記されています。

表記例 説明

File → Exit を選択して、... メニューコマンドは、青の太字で表記
します。

OK をクリックして、... ユーザーインターフェース上のボタン
名は、青の太字で表記します。

<Ctrl> を押して、... キーボードの各キーは、< > で囲んで表
記します。

“Open File”ダイアログボックスが
開きます。

プログラムウィンドウ、ダイアログ
ボックス、入力フィールド等のタイト
ルは、“ ”で囲んで表記します。
はじめに



特に重要な注意事項は、以下のように表記されています。

また PDF 文書において、索引、および他の部分を参照する個所（例：「xx を参照
してください」の中の「xx」の部分）については、その参照先へのリンクが設け
られているので、必要な参照個所を素早く見つけることができます。

setup.exeファイルを選択しま
す。

リストボックス、プログラムコード、
ファイル名、パス名等のテキスト文字
列は、Courierフォントで表記しま
す。

論理型のデータから算術型のデータ
への変換はできません。

注意すべき個所、または新出の用語は
太字 、あるいは「 」で囲んで表記され
ます。

OSEK グループ（http://www.osek-
vdx.org/ を参照してください）はさま
ざまな標準規格を策定しています。

インターネットへのリンクは、青い下
線で表記されています。

注記

ユーザー向けの重要な注意事項

表記例 説明
はじめに 7
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2 プログラムのインストール

この章は、PC またはネットワーク上に ASCET をインストールし、ASCET プログ
ラムのメンテナンスやアンインストールを行うすべてのユーザー、および ASCET
をファイルサーバに供給してネットワーク経由のインストールを行うシステム管
理者を対象としています。ここには、製品の内容、スタンドアロンインスタレー
ションとネットワークインスタレーションに必要なハードウェアやソフトウェア
の条件、およびインストールに必要な準備について、重要な情報が記載されてい
ます。また、ASCET のインストールとアンインストールの手順も紹介していま
す。

2.1 準備

インストールを行う際は、まず製品の内容に不足がないこと、またお手持ちのコ
ンピュータがシステム要件を満たしていることを確認してください。使用するオ
ペレーティングシステムとネットワーク接続によっては、インストールを行うた
めに必要なユーザー特権を持っていることを確認する必要があります。

2.1.1 製品の内容

ASCET は、以下のアイテムで構成されます。

• ASCET CD- ROM

－ ASCET のインストールプログラム

－ ASCET マニュアルおよび ETAS ハードウェアのドキュメント（PDF
ファイル、開くためには Acrobat Reader が必要です）

－ エンドユーザー向け FLEXnet ライセンスユーザーズガイド（PDF ファ
イル）

－ Acrobat Reader のインストールプログラム

また、ASCET を使用するには、ライセンス契約に基づいて発行されたライセンス
ファイルが必要です。このファイルは、システム管理者の方から、または ETAS
ホームページのセルフサービスポータルサイト（http://www.etas.com/support/
licensing）から入手できます。ライセンスファイルのお申し込み時には、受注プ
ロセスにおいて ETAS から発行された「アクティベーション番号」が必要です。

2.1.2 システム要件

ASCET を使用する PC は、以下の条件を満足している必要があります。

• 1GHz Pentium PC （2GHz 以上を推奨）

• Windows® 2000、Windows® XP、Windows® Vista
• 512MB RAM

• 空き容量が 1GB（プログラムデータ用サイズを含まず）以上のハードディ
スク

• CD ROM ドライブ
プログラムのインストール 9
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• VGA グラフィックカードと VGA モニタ、256 色、800 × 600 以上の解像度

2.1.3 インストールと運用に必要なユーザー特権

インストールに必要なユーザー特権 :

ASCET を PC にインストールするには、管理者のユーザー特権が必要です。ない
場合は、システム管理者の方にお問い合わせください。

運用に必要なユーザー特権 :

ASCET を使用するユーザーは、管理者から“スケジューリング優先順位の繰り上
げ”という特権を受ける必要があります。この特権は、ユーザーマネージャーを
使用して設定します。

推奨：一般的には、以下のようにして“スケジューリング優先順位の繰り上げ”
特権をローカルの“Users”グループに設定してください。

Windows 2000 でユーザー特権“スケジューリング優先順位の繰り上げ”を割
り当てる：

• Windows のスタートメニューから、設定 → コン
トロールパネル → 管理ツール → ローカルセキュ
リティポリシー を選択します。

• ローカルポリシー → ユーザー権利の割り当て に
含まれる“スケジューリング優先順位の繰り上
げ”をダブルクリックします。

• 追加 ボタンをクリックします。

• ローカルコンピュータを選択します。

• “Users”グループをダブルクリックして“スケ
ジューリング優先順位の繰り上げ”を割り当てま
す。

• OK ボタンをクリックして確定します。

• OK ボタンで“ローカルセキュリティポリシーの
設定”ダイアログボックスを閉じます。

• ローカルセキュリティ設定を終了します。

Windows XP でユーザー特権“スケジューリング優先順位の繰り上げ”を割り
当てる：

• Windows のスタートメニューから、設定 → コン
トロールパネル → 管理ツール → ローカルセキュ
リティポリシー を選択します。

注記

下記の設定を行うためには、管理者権限が必要です。
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• ローカルポリシー → ユーザー権利の割り当て に
含まれる“スケジューリング優先順位の繰り上
げ”をダブルクリックします。

“スケジューリング優先順位の繰り上げ”ダイア
ログボックスが開きます。

• ユーザーまたはグループの追加 ボタンをクリック
します。

“ユーザーまたはグループの選択”ダイアログ
ボックスが開きます。

• 場所 ボタンをクリックします。

“場所”ダイアログボックスが開きます。

• ローカルコンピュータを選択し、OK をクリック
して“場所”ダイアログボックスを閉じます。

• “ユーザーまたはグループの選択”ダイアログ
ボックスで、詳細設定 ボタンをクリックして、自
動検索機能を有効にします。

• 今すぐ検索 ボタンをクリックして、ローカルコン
ピュータに登録されているユーザーのリストを表
示します。

• “名前（RDN）”のカラムから、スケジューリング
優先度の繰り上げの権利を割り当てたいユーザー
またはグループを選択します。

• OK ボタンをクリックして確定します。

• OK ボタンで“ユーザーまたはグループの選択”
ダイアログボックスを閉じます。

• OK ボタンで“スケジューリング優先順位の繰り
上げ”ダイアログボックスを閉じます。

• ローカルセキュリティ設定を終了します。

Windows Vista でユーザー特権“スケジューリング優先順位の繰り上げ”を割
り当てる：

• Windows のスタートメニューから、 コントロール
パネル → 管理ツール → ローカルセキュリティポ
リシー を選択します。

• ローカルポリシー → ユーザー権利の割り当て に
含まれる“スケジューリング優先順位の繰り上
げ”をダブルクリックします。

“スケジューリング優先順位の繰り上げ”ダイア
ログボックスが開きます。
プログラムのインストール 11
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• ユーザーまたはグループの追加 ボタンをクリック
します。

“ユーザー、コンピュータまたはグループの選択”
ダイアログボックスが開きます。

• 場所 ボタンをクリックします。

“場所”ダイアログボックスが開きます。

• ローカルコンピュータを選択し、OK をクリック
して“場所”ダイアログボックスを閉じます。

“ユーザー、コンピュータまたはグループの選択”
ダイアログボックスの名前が“ユーザーまたはグ
ループの選択”に変わります。

• “ユーザーまたはグループの選択”ダイアログ
ボックスで、詳細設定 ボタンをクリックして、自
動検索機能を有効にします。

“ユーザーまたはグループの選択”ダイアログ
ボックスが開きます。

• 今すぐ検索 ボタンをクリックして、ローカルコン
ピュータに登録されているユーザーのリストを表
示します。

• “名前（RDN）”のカラムから、スケジューリング
優先度の繰り上げの権利を割り当てたいユーザー
またはグループを選択します。

• OK ボタンをクリックして確定します。

• OK ボタンで“ユーザーまたはグループの選択”
ダイアログボックスを閉じます。

• OK ボタンで“スケジューリング優先順位の繰り
上げ”ダイアログボックスを閉じます。

• ローカルセキュリティ設定を終了します。

2.2 インストール

いずれかのアドオン製品（ASCET-MD、ASCET-RP、ASCET-SE、ASCET-SCM）
をインストールする際は、まず最初に ASCET の基本システムをインストールする
必要があります。また ASCET-SCM をインストールするには、先に ASCET-MD、
ASCET-RP、ASCET-SE のいずれかをインストールする必要があります。

インストールの方法は、CD から行う場合もネットワークドライブから行う場合
も同様です。

2.2.1 項で基本システムのインストール方法を詳しく説明します。アドオン製品
のインストール方法は 2.2.2 項に簡単に説明されていますが、より詳しい情報が
必要な場合は、各アドオン製品のマニュアルやリリースノートをご覧ください。
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特殊なインストール条件（インストールのキャンセル、既存のプログラムバー
ジョンへの上書き等）については、21 ページの 2.2.3 項に説明されています。ま
たコマンドラインからインストールを実行する場合は 2.2.4 項の情報を参照して
ください。

2.2.1 ASCET 基本システムのインストール

ASCET のインストールを開始する：

• インストールディスクをPCのディスクドライブに
挿入します。

• ディスクが自動的に起動しない場合は
start.exeをダブルクリックします。

インタレーションダイアログボックスが開きま
す。

• Main というリンクをクリックします。

• ASCET というリンクをクリックします。
プログラムのインストール 13
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ASCET 基本システムのインストールが開始しま
す。

ライセンス契約の内容を確認する：

• “EULA”というタイトルのダイアログボックスが
開き、ライセンス契約の内容が表示されるので、
内容に同意いただける場合は、Accept オプショ
ンをクリックしてオンにしてください。

• OK をクリックして確定します。

• 画面に表示される指示に従って先に進みます。

ダイアログボックス内に設定した内容を確定する
には、Next ボタンをクリックして次のダイアロ
グボックスに進みます。Back ボタンをクリック
すると前のダイアログボックスに戻り、また
Cancel をクリックするとインストールが中止さ
れます。

ASCET を登録する：

• 以下のダイアログボックスに、ユーザーの個人情
報を入力します。

注記

ASCET-MD やその他の ASCET 製品（ASCET-DIFF
以外）をインストールするには、あらかじめ
ASCET 基本システムをインストールしておく必要
があります。
プログラムのインストール



• Next ボタンをクリックします。

ASCET の登録が終わると、インストール先のターゲットディレクトリを指定する
ように要求されます。この指定は、次のダイアログボックスで行います。

ASCET のパスを指定する：

プログラムファイルとプログラムデータは別のディレクトリに格納されます。後
でプログラムをアンインストールしたり更新すると、プログラムファイルだけが
削除または上書きされます。プログラムデータはそのまま残り、継続して使用可
能です。プログラムデータには以下のデータが含まれます。

• データベース

• ユーザープロファイル

• デフォルトのディレクトリを変更したい場合に
は、Browse ボタンをクリックします。

• ダイアログボックスから、希望のディレクトリを
選択します。

存在しないディレクトリを指定すると、インスタ
レーションルーチンがそのディレクトリを自動的
に作成します。

注記

ASCET のインストールディレクトリのパスには、スペース文字を含めることが
できます。ただしその際は、ASCET と共に使用する外部ツールも空白文字を含
むパス名をサポートしている必要がありますので、確認してからインストール
を行ってください。
プログラムのインストール 15
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• Next ボタンをクリックします。

“Select global directories”ダイアログボックス
が開きます。ここでログファイルは一時ファイル
の保存先を指定します。

• デフォルトのディレクトリを変更したい場合に
は、Browse ボタンをクリックします。

• Next ボタンをクリックします。

“Select Handling of ETAS Shared modules”ダイアログボックスでは、ETAS の
全製品で使用する基本モジュールの共有に関する設定を行います。

共有ファイルの設定を行う：

• モジュールを他の製品と共有して使用するには、
share modules between products オプション
をオンにします。

複数の ETAS 製品を同時に使用する場合は、こち
らの設定をお勧めします。

• モジュールのコピーをインストールしてASCET専
用で使用するには、 use local copies for each 
product オプションをオンにします。各コンポー
ネントを個別に調整する必要がある場合は、こち
らの設定にしてください。

• デフォルトのディレクトリを変更したい場合に
は、Browse ボタンをクリックします。

• Next ボタンをクリックします。
プログラムのインストール



インストールする機能を指定する：

“Select options”ダイアログボックスで、ASCET の機能範囲を指定します。

• インストールしたいモジュールをチェックしま
す。

以下のオプションを選択できます。

－ “AS-Editor” - 算術演算サービスエディタ

－ “ASD-Database” - ETAS システムライブラリ
とチュートリアルデータベースを、ASCET
のインストールディレクトリにエクスポート
します。

－ “ASD-Manual” - ASCET マニュアル（PDF）
を ETAS¥ETASManualsディレクトリにイ
ンストールします。

－ “ASD-OnlineHelp” - ASCET オンラインヘル
プを ETAS¥ASCET5.2¥helpディレクト
リにインストールします。

－ “ASD-ToolAPI” - ASCET の Automation イン
ターフェースをインストールします。

• Next ボタンをクリックします。
プログラムのインストール 17
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スタートメニューに表示される ASCET フォルダ名を指定する：

• デフォルトのフォルダ名を有効にします。

または

• 別のフォルダ名を指定します。

• Next ボタンをクリックします。

ASCET をインストールする：

• “Ready to Install”ダイアログボックスで Next を
クリックして、インストールを開始します。

プログラムファイルがコピーされます。コピーの
進捗状況は、棒グラフによって表されます。

必要に応じて ETAS ライセンスマネージャがイン
ストールされます。

最後に“Installation complete”というダイアロ
グボックスが開きます。

• Finish をクリックします。

インストールが完了します。

注記

次のステップで、実際のインストール処理が開始されます。
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PC が再起動されると、Windows のスタートメニューの ETAS フォルダ内に、指
定した名前の ASCET フォルダが表示され、その中に以下のアイテムが表示されま
す。

• ASCET Help

ASCET オンラインヘルプを開きます。

• ASCET Uninstall

アンインストールルーチンを起動します（2.5 項を参照してください）。

• ASCET V6.0

ASCET プログラムを起動します。

• AS Editor

AS エディタを起動します（詳しくは ASCET オンラインヘルプをご参照く
ださい）。

• ETAS Network settings

ETAS ネットワークの設定を行うツールを起動します。

• LicenseInfo

“Obtain License Info”ダイアログボックスを開きます（第 3 章を参照し
てください）。

• Online manuals

オンラインマニュアルがインストールされている場合は、ここからマニュ
アルディレクトリ ETAS¥ETASManualsを開くことができます。各マ
ニュアルはこのディレクトリ下のサブディレクトリに保存されています。

• PC RemoteControl

リモートインターフェースの設定を有効にします。

• ReadMe

ASCET V6.0 についての最新情報が収められているファイルを開きます。

ETAS ライセンスマネージャについては、Windows のスタートメニューの ETAS
フォルダ内に License Management という独立したフォルダが作成されます。

ASCET のインストールディレクトリの下の exportディレクトリ内には 3 つの
サンプルファイル（*.expまたは *.amd）がコピーされていて、これらのファ
イルを ASCET データベースにインポートすることができます。

• SystemLibETAS.* および ETASSystemLibCT.* - ETAS システム
ライブラリ（PT1 エレメントなどの基本モデリングブロックやその他の基
本フィルタエレメント、積分器などが含まれます）

• Tutorial.* - ETAS チュートリアル
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2.2.2 ASCET-MD およびその他の ASCET 製品のインストール

基本システムをインストールした後は、ASCET-MD やその他のアドオン製品をイ
ンストールすることができます。

ASCET アドオン製品をインストールする：

• 再度インタレーションダイアログボックスを開
き、Main リンクをクリックします。

• ASCET-MD（またはその他の ASCET 製品）のリン
クをクリックします。

• 画面の指示に従ってインストールを行います。

選択された製品がインストールされます。

注記

ASCET-MD やその他の ASCET 製品（ASCET-DIFF
以外）をインストールするには、あらかじめ
ASCET 基本システムをインストールしておく必要
があります。
また、ASCET-SCM を使用するには、あらかじめ
ASCET-MD、ASCET-RP、ASCET-SE のいずれかが
インストールされている必要があります。
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2.2.3 特殊な条件でのインストール

インストールの中止

インストールの途中でインストールを中止するには、以下のように操作してくだ
さい。

インストールを中止する：

• 操作中のダイアログボックスで、Cancel ボタン
をクリックします。

• 元のダイアログに戻るには、Resume をクリック
します。

• セットアッププログラムを終了してインストール
を中止するには、Exit Setup ボタンをクリック
します。

• OK をクリックすると、インストールが中止され
ます。

旧バージョンに「上書きインストール」を行う

インストールしようとするソフトウェアの旧バージョンがすでにインストールさ
れている場合、または指定されたディレクトリに別のソフトウェアがすでにイン
ストールされている場合、その旨を通知するメッセージが表示されます。このよ
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うな状況は、たとえばバージョン 6.0.0 がインストールされている PC にバー
ジョン 6.0.1. をインストールしようとした場合に発生します。その場合は以下の
ように操作してください。

既存のプログラムバージョンに上書きしてインストールする：。

• 表示されたメッセージをよく読んでください。

この例では、指定のディレクトリに旧バージョン
がすでにインストールされていることが示されて
います。以降の処理を続行すると、これらのファ
イルは上書きされます。

• 他のディレクトリにインストールするには、
Back ボタンをクリックします。

• 既存のファイルに上書きしてよければ、Yes, 
overwrite it ボタンをクリックします。

• 上記の確認メッセージが表示されるので、Yes, 
overwrite it! をクリックして確定します。

上書きせずに元のダイアログボックスに戻るには
No をクリックします。
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既存のディレクトリに「上書きインストール」を行う

指定されたディレクトリがすでに存在していて、そこに ASCET が完全にインス
トールされていない場合、その旨を通知するメッセージが表示されます。このよ
うな状況は、前回のインストール処理が途中でキャンセルされた場合などに発生
します。その場合は以下のように操作してください。

既存のディレクトリに上書きする：

• 表示されたメッセージをよく読んでください。

この例では、指定されたディレクトリがすでに存
在していることを示しています。

• 他のディレクトリにインストールするには、
Back ボタンをクリックします。

• 既存のディレクトリに上書きしてよければ、Yes, 
delete it ボタンをクリックします。
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• 確認メッセージが表示されるので、Yes, delete 
all! をクリックして確定します。

ASCET がインストールされて、既存のファイル
はすべて削除されます。

上書きを行わずに前のダイアログボックスに戻る
には No をクリックします。

管理者権限がない場合

Windows にログオンした時のユーザー名に管理者権限が与えられていない場合、
以下のメッセージボックスが開きます。ASCET のインストールを行うには管理者
権限が必要であるため、メッセージを確認した後は、インストール処理は中断さ
れます。

管理者権限なしでインストールを実行しようとした場合：

• メッセージを確認して OK をクリックします。

インストールは中断されます。

• システム管理者の方に問い合わせてください。

• 必要な権限を取得した後、再度インストールを
行ってください。

2.2.4 コマンドラインからのインストール

インストールをコマンドラインから実行する場合は、引数を使用してインストー
ル処理をカスタマイズすることができます。
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/silent または /s

「サイレントモード」でインストールを行います。このモードにおいては
ユーザーの介入を必要とするダイアログボックスが開きません。通常のイ
ンストールにおいてダイアログボックスで入力される情報の代わりに、デ
フォルト値、または install.iniから読み込まれた値が使用されます。
エラーメッセージも表示されません。

サイレントインストールの処理は、バックグラウンドプロセスによって実
行されます。インストール中は Windows のシステムトレイにアイコンが
表示されますが、ユーザーがこのプロセスに介入することはできません。

インストールディレクトリ内の silent.logというファイルにインス
トールログが記録されます。このファイルは *.iniと同じ形式で、サイ
レントモードでインストールされた各 ASCET 製品ごとにセクションが作
成されます。インストール実行中は、その製品のセクションに以下の行が
記録されます。

install=in progress

インストールが正常に終了すると、その行は以下のように書き変わりま
す。

install=successfully finished

インストール後に PC の再起動が必要な場合は、install.ini内に所定
のエントリ1 で指定されていない限り自動的に再起動が行われます。以下
の行が所定のセクションに追加されます。

need reboot=yes

/basic

「ベーシックモード」でのインストールを行います。このモードにおいて
は、ライセンス契約についての情報が表示される“EULA”というタイト
ルのダイアログボックスを除き、ユーザーの介入を必要とするダイアログ

1. [SilentInstallation]
;prevents a silent installation from rebooting when
;set to "Suppress"
Restart=Suppres 

注記

/silentは、コマンドラインの最初の引数として使用してください。
他の引数が先に指定されると、/silentは無効となります。
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ボックスが開きません。サイレントモードと同様のインストールが行われ
ますが、ベーシックモードにおいては進捗バーとエラーメッセージが表示
され、ログファイルは生成されません。

/ini="<MyPath>\<IniFileName>.ini"

デフォルト状態において、インストール時にはインストールディレクトリ
に保存されている install.iniファイルが使用されます。しかし、1
つのネットワークドライブから複数のユーザーが ASCET 製品をインス
トールするには、使用環境に応じて異なる *.iniファイルが必要となる
場合があります。そのような場合は、以下のようにしてファイルのパスを
指定します。

インストールディレクトリ外にある *.iniファイルを使用する場合： 
/ini="<MyPath>¥<IniFileName>.ini"

インストールディレクトリ内にある *.iniファイルを使用する場合： 
/ini=".¥<IniFileName>.ini"

/? または /h

使用できるコマンドライン引数の一覧が表示されます。

2.3 ネットワーク経由のインストール

CD からだけでなく、PC 上のネットワークドライブからも ASCET をインストー
ルできます。

ネットワークインスタレーションには、PC に実際にインストールする前にあらか
じめインストールオプションを設定しておくことができるという利点があります

（2.3.2 を参照してください）。

2.3.1 ファイルの準備

ネットワークドライブからインストールを可能にするため、まずインストールに
必要なファイルを CD からネットワークドライブ上にコピーしておく必要があり
ます。 

ファイルをネットワークサーバにコピーする：

• 任意のネットワークドライブ上にソースディレク
トリを作成します。

• CD の全データをソースディレクトリにコピーし
ます。

注記

ASCET 製品の中には、install.ini内に環境変数を定義できたりサイレン
ト／ベーシックモードを制御するための設定を定義しておく必要があるものが
あります。詳しくは各製品のドキュメントを参照してください。
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インスタレーションログ

ユーザーがネットワークインスタレーションを行った履歴は、ネットワーク上の
ログファイルに記録されます。したがって、すべてのユーザーに、x:¥user
ディレクトリ、または install.iniに指定されたディレクトリに対する書き
込みアクセス権が必要です。

2.3.2 ネットワークインスタレーションのカスタマイズ

ユーザーが自分のワークステーションに ASCET をインストールする前に、
ASCET のデフォルトのインストールオプションをカスタマイズしておくことがで
きます。

ネットワークインスタレーションの場合、以下のことが可能となります。

• ディレクトリなどのデフォルト設定を変更しておくことにより、インスタ
レーションダイアログをカスタマイズできます。

• ASCET のインストールを、ユーザーの介入なしにバックグラウンドで完全
に自動実行できます。

• カスタマイズしたファイルで製品のデータディレクトリ（デフォルト設定
は [drive]:¥ETASdata¥ASCET6.0¥...）内のファイルを上書きし
たり、既存のディレクトリにファイルが追加されるように指定できます。

インスタレーションダイアログのカスタマイズ

大規模な部署内で多くのユーザーがネットワークインスタレーションを行うよう
な場合、インストールに使用されるオプション情報のデフォルト設定をあらかじ
めカスタマイズしておいて、各 PC に同じ条件でインストールが行われるように
する必要が生じる場合があります。このようなカスタマイズは、install.ini
コンフィギュレーションファイルを使えば可能です。このファイルは、インスタ
レーションディレクトリに格納されています。

以下の例に従って、デフォルト設定を変更してください。

コンフィギュレーションファイルをカスタマイズする：

• install.iniファイルをテキストエディタで開
きます。

以下は、この INI ファイルのデータの一例です。

;Sets the main directory of ASCET

;MainDir=c:¥etas¥ASCET6.0

• デフォルト設定を修正するには、MainDirキー
ワードの行の“;”（コメントを示す）を削除しま
す。
プログラムのインストール 27



28
• パスを、たとえば
H:¥programs¥etas¥ASCET6.0というよう
に変更します。

ファイルの内容は、以下のようになります。

;Sets the main directory of ASCET

MainDir=H:¥programs¥etas¥ASCET6.0

• install.iniの他の部分も、同じ方法で適宜変
更します。

• 変更内容を保存してから、エディタを閉じます。

これで、ASCET.exeを実行してインストールを開始すると、ダイアログボック
スには新しい設定がデフォルトオプションとして表示されるようになります。

自動インストール

ASCET.exe ¥sというコマンドを実行すると、ASCET のインストールがバック
グラウンドで完全に自動実行されます。ユーザーの介入は一切必要なく、その時
点で有効なデフォルト設定が自動的に選択されます。install.iniファイル内
の各デフォルト設定は任意に変更できます（27 ページの「インスタレーションダ
イアログのカスタマイズ」を参照してください）。

システム管理者が“ASCET.exe ¥s”コマンドを含むバッチファイルを作成し、
install.ini内の必要な設定を行えば、ユーザーはこのバッチファイルを実行
するだけで、一切の入力作業なしにインストール作業を実行できるようになりま
す。

なおこのインストール方法においてはダイアログボックスはまったく表示されな
いので、インストールが完了した時点でユーザーに通知を行うメカニズムを用意
しておくとよいでしょう。

ASCET ファイルのカスタマイズ

以下に説明するようなカスタマイズ機能を利用してインストールプログラムを調
整し、インストール実行時にカスタマイズされたファイルをデフォルトファイル
に上書きしたり、他のファイルをインスタレーションセットに含めたりすること
ができます。

この機能によって、カスタマイズされたデータベース、ユーザープロファイル、
およびダイアログボックステンプレートをインストールされるプログラムに統合
することが可能となります。

このしくみは比較的単純です。インスタレーションディレクトリ下に
InstData¥...というサブディレクトリを作成し、正しいディレクトリ構造を
維持しながら、カスタムファイルをそこにコピーします。

注記

パス設定の変更により、以下のようなカスタムインストールが可能です。
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カスタムファイルを作成するには、まず ASCET をテスト用 PC にインストール
し、これを用いてファイルを作成します。

ASCET のデフォルトインストールを行うと、ETASData¥ASCET6.0¥...ディ
レクトリに以下のようなサブディレクトリが作成されます。そこには ASCET のデ
フォルト設定を定義するファイルがあり、それらをカスタマイズすることが可能
です。

• Database¥DB¥

dbサブディレクトリには、デフォルトのデータベースが格納されていま
す。ここに、たとえば Database¥DemoDB¥といった別のデモ用データ
ベースを作成できます。

• User¥[user name] - Windows のログインユーザー名により異なる

[user name]サブディレクトリには、デフォルトのユーザープロファ
イルが格納されます。設定可能なオプションはすべて、このサブディレク
トリに保存されます。

ネットワークインスタレーション用のデータをカスタマイズする：

• ASCET を PC にインストールします。

• ASCET を起動します。

• ユーザープロファイルを修正します。

• データベースを修正するか、新しいデータベース
を追加します。

• ASCET を終了します。

ここまででカスタマイズは終了したので、これらのファイルをインスタレーショ
ンプログラムに統合します。次の 2 通りの方法があります。

• 同じ名前の既存のファイルにカスタムファイルを上書きします。これを行
うためには、InstData¥overwrite¥というフォルダをインスタレー
ションディレクトリに作成しておく必要があります。

• カスタムファイルの名前を変更して、それらを既存のファイルに追加しま
す。同じ名前のファイルは上書きされません。これを行うためには、
InstData¥add-only¥というフォルダをインスタレーションディレク
トリに作成しておく必要があります。

カスタムファイルをインスタレーションプログラムに含める場合、必ずその親
ディレクトリもコピーしてください。ETASData¥ASCET6.0¥ディレクトリの
レベルは、InstData¥overwrite¥や InstData¥add-only¥と同じでなけ
ればなりません。

例：

InstData¥overwrite¥user¥userDef.ini

InstData¥add-only¥database¥additionalDB¥
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修正済みのユーザープロファイルを統合する：

• カスタマイズした
ETASData¥ASCET6.0¥user¥[user 
name]¥ascetsd.iniファイルを
InstData¥overwrite¥user¥サブディレク
トリにコピーします。

• ascetsd.iniファイルの名前を
userDef.iniに変更します。

これで、インストール後は、新規のユーザー用と
してこの初期化ファイルが使用されるようになり
ます。

修正を加えたデータベースを統合する：

• カスタマイズしたデータベース、つまり
¥database¥DB¥ サブディレクトリを
InstData¥add-only¥...サブディレクトリ
にコピーします。

• DBディレクトリの名前を任意に変更します。変更
しないとデータベースはコピーされません。

もちろん、InstData¥overwrite¥ディレク
トリを用いて DBデータベースを上書きすること
もできます。

ASCET.exeでインストールルーチンを起動すると、デフォルトファイルはカス
タムファイルで上書きされ、対応するディレクトリに新しいファイルが追加され
ます。

2.3.3 ネットワークドライブからの ASCET のインストール

ネットワークドライブからのインストールは、CD-ROM から行う場合と同じ手順
でインストールできます。ネットワークドライブ上のどのディレクトリにインス
トールプログラムが格納されているかを確認してから、12 ページの「インストー
ル」の項を参照してインストールしてください。

注記

ネットワークドライブから ASCET をインストールするには、ネットワークドラ
イブのログディレクトリへの書き込みアクセス権が必要です（2.3.1 を参照し
てください）。
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2.4 ASCET ディレクトリ

ASCET をインストールすると、インストール先のディスクに以下のディレクトリ
構造が生成されます（インストール時に別のパスを指定することもできます）。

2.4.1 デフォルトのデータディレクトリ

• データベース
ETASData¥ASCET6.0¥Database

• エクスポート
ETASData¥ASCET6.0¥Export
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• インポート
ETASData¥ASCET6.0¥Export

• 生成されるコード
ETAS¥ASCET6.0¥CGen 

• 自動生成されるドキュメント
ETASData¥ASCET6.0¥Docu

2.4.2 デフォルトディレクトリの変更

ASCET の“Options”ダイアログボックスで、データディレクトリのデフォルト
設定を変更することができます。以下のように操作してください。

データディレクトリのデフォルト設定を変更する：

• ASCET のコンポーネントマネージャからメニュー
コマンド Tools → Options を選択します。

“Options”ダイアログボックスが開きます。各
データディレクトリのデフォルト設定は、以下の
ノードで行います。

データベース： “Options”
エクスポート： “Integration”/“Export”
インポート： “Integration”/“Impot”
コード生成： “Build”
ドキュメント： “Documentation"
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• 変更したいパスの右側のボタンをクリックしま
す。

“Path selection”ダイアログボックスが開きま
す。

• デフォルトディレクトリとして使用したいディレ
クトリを指定します。

• OK をクリックします。

指定されたディレクトリが“Options”ダイアロ
グボックスに表示されます。

• 変更したいすべてのオプションについて、以上の
手順を繰り返します。

• 設定が終了後、OK をクリックすると設定内容が
確定され、Cancel をクリックすると取り消され
ます。
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2.5 ASCET のアンインストール

ASCET をアンインストールすると、インストールされている ASCET 製品すべて
が自動的にアンインストールされます。各 ASCET ファミリ製品（ASCET-MD、
ASCET-SE、ASCET-RP）やアドオン製品を個別にアンインストールすることはで
きません。

2.5.1 自動アンインストール

ASCET を自動アンインストールする：

• スタートメニューのプログラムグループから、
ASCET Uninstall を選択します。

以下のダイアログボックスが開きます。

• Automatic を選択します。
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• Next ボタンをクリックします。

• アンインストールを実行するには Finish ボタンを
クリックします。
プログラムのインストール 35
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アンインストール実行中にアンインストール処理を中止することもできます。
Cancel ボタンをクリックすると、以下のダイアログボックスが開きます。

2.5.2 カスタムアンインストール

ASCET をマニュアル操作でアンインストールする：

• スタートメニューのプログラムグループから、
ASCET Uninstall を選択します。

以下のダイアログボックスが開きます。

• Custom を選択します。

注記

キャンセルした時点でデータがすでに消去されていた場合は、ASCET を再イン
ストールする必要があります。
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• Next ボタンをクリックします。

“Select Private Files to Remove”ダイアログボッ
クスが開きます。

• “Select Private Files to Remove”ダイアログボッ
クスで、削除したいファイルを選択します。

• Next ボタンをクリックします。

• “Select Directories to Remove”ダイアログボッ
クスで、削除したいディレクトリを選択します。

• Next ボタンをクリックします。

• “Select INI Files to Remove”ダイアログボックス
で、削除したい *.iniファイルを選択します。

• Next ボタンをクリックします。

• “Select INI Items to Edit”ダイアログボックスで、
編集したい *.ini エントリを選択します。

• Next ボタンをクリックします。

• “Select Registry Keys to Remove”ダイアログ
ボックスで、削除したいレジストリキーを選択し
ます。

• Next ボタンをクリックします。

• “Select Registry Trees to Remove”ダイアログ
ボックスで、削除したいレジストリフォルダを選
択します。

• Next ボタンをクリックします。
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• “Select Registry Keys to Edit”ダイアログボック
スで、編集したいレジストリキーを選択します。

• Next ボタンをクリックします。

• “Select Sub-Systems to Remove”ダイアログ
ボックスで、削除したいサブシステムを選択しま
す。

• Next ボタンをクリックします。

• “Perform Uninstall”ダイアログボックスで、
Finish ボタンをクリックします。

アンインストールが実行されます。

カスタムアンインストール実行中でも、自動アンインストールの場合と同様に
Cancel ボタンでアンインストールを中止することができます。

注記

キャンセルした時点でデータがすでに消去されていた場合は、ASCET を再イン
ストールする必要があります。
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3 ライセンスについて

ASCET 製品ファミリに含まれるすべての ASCET 製品とそのアドオン製品は、ラ
イセンス管理の対象となります。製品をインストールした後に ASCET を使用する
には、ご使用の PC 専用のライセンスファイルを ETAS から入手し、それを PC に
インストールする必要があります。このファイルがない場合、ASCET をインス
トールすることはできますが、実際に使用することはできません。

3.1 ライセンスの取得

ASCET を使用するために必要なライセンスファイルは、システム管理者の方か
ら、または ETAS ホームページのセルフサービスポータルサイト（URL はライセ
ンス契約に関する ETAS からのレターに記載されています）から入手してくださ
い。ライセンスファイルを ETAS にお申し込みいただく際には、受注プロセスに
おいて ETAS から発行された「アクティベーション番号」が必要です。

ライセンスは、特定のユーザー名または PC に対して割り当てられます。まずは
ライセンスファイルを取得するために必要な情報を、ETAS ライセンスマネージャ
を使用して以下のように取得し、ETAS にお送りください。

ライセンスファイルを取得する：

• Windows のスタートメニューから、プログラム 
→ ETAS → License Management → ETAS 
License Manger を選択します。

または

• ASCETのコンポーネントマネージャから Help → 
License Info を選択します。

ライセンスマネージャが起動して、“ETAS 
Licensing”というタイトルのダイアログボックス

が開きます。
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• Continue をクリックします。

ETAS ライセンスマネージャが開きます。

ETAS ライセンスマネージャには、インストール済みの各 ASCET 製品のエントリ
が表示され、ETAS の他の製品用のライセンスがインストールされている場合はそ
れらのエントリも表示されます。各エントリ行の先頭の列と“Statuis”列には、
有効なライセンスがすでにインストールされているかどうかが表示されます。

• Tools → Obtain License Info を選択します。

“Obtain License Info”ダイアログボックスが開

きます。PC に組み込まれている各ネットワーク

アダプタ（ネットワークカード）のホスト ID
（MAC アドレス）と IP アドレスが表示されます。
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• リストアップされているネットワークアダプタの
いずれかを選択し、Get License Info をクリッ
クします。

その PC 用のライセンスファイルを作成するため

に必要な情報が収集され、“License Info”ダイア

ログボックスに表示されます。

• OK をクリックして、表示された情報を所定のテ
キストファイルに保存します。

• ファイル選択ダイアログボックスで、テキスト
ファイルのパスとファイル名を設定します。

• Save をクリックします。

ファイルが作成され、テキストエディタで自動的
にそのファイルが開きます。このファイルには、
ユーザー名とホスト ID のほか、ユーザーの E
メールアドレス、ライセンス番号、その他の情報
を入力する行と、ファイルの送信先アドレスが含
まれています。

• ライセンス契約書に記載されたライセンス番号を
入力し、必要に応じてその他の情報を入力し、最
後にそのファイルを保存してください。

• “Obtain License Info”ダイアログボックスを閉
じます。
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• 完成したテキストファイルを E メールに添付して
ETAS に送信します。

ASCET の場合、各 ASCET 製品（ASCET-MD、

ASCET-MIP など）ごとにファイルを作成してお

送りいただく必要があります。

ETAS から、ユーザー ID とホスト ID に対応する

ライセンスキーが格納されたライセンスファイル
をお送りします。

取得したライセンスファイルは、以下のようにして PC にインストールします。

ライセンスファイルをインストールする：

• ETAS ライセンスマネージャを開きます（39 ペー
ジ参照）。

• ETAS ライセンスマネージャで File → Add 
Licensing File を選択します。

“Install License”ダイアログボックスが開きます。

• “Select License File”フィールドの右側にある ... 
ボタンをクリックします。

注記

ETAS から送られてきたライセンスファイルは編集
しないでください。編集されたライセンスファイ
ルは無効になってしまいます。
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• ファイル選択ダイアログボックスで、ASCET 
V6.0 用のライセンスファイルを選択して Open 
をクリックします。

“Install License”ダイアログボックスに、選択さ
れたライセンスファイルの情報が表示されます。

• OK をクリックしてライセンスファイルをインス
トールします。

ETAS ライセンマネージャに、上記の操作で選択されたライセンスの情報が表示さ
れます。エントリの先頭部分に表示された緑のチェックマークシンボルが、ライ
センスが有効であることを示します。

• Close をクリックしてETASライセンスマネージャ
を閉じます。

注記

上記ダイアログボックスの“Version”列に表示さ
れる番号は、ライセンスのバージョン番号で、ソ
フトウェアのバージョン番号とは異なります。

注記

上記の操作を行っても緑のシンボルが表示されない場合、ライセンスファイル、
または他の製品に関連するライセンスに何らかの問題がある可能性があります。
ETAS ライセンスマネージャについての詳しい情報は、ETAS ライセンスマネー
ジャのオンラインヘルプを参照してください。
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指定されたディレクトリ内に有効なライセンスファイルが見つからなかった場合、
ASCET-MD、ASCET-RP、ASCET-SE はトライアルモードで起動します。この場
合、ある一定の期間は通常どおりに操作を行えますが、ライセンスファイル検索
が定期的に行われ、ファイルが見つからない場合はワーニングメッセージが表示
されます。

その他のアドオン製品（INTECRIO-ASC など）にはトライアルモードはないので、
ライセンスなしには操作を行えません。

ライセンスファイルがない状態で所定のトライアル期間が経過すると、ワーニン
グメッセージの代わりにエラーメッセージが表示され、ライセンスファイルが見
つかるまでツールは使用できなくなります。 

3.2 ライセンスの借用

サーバーライセンスを使用している場合、一時的にローカルライセンスが必要に
なった際に（ラップトップ PC で車上テストを行うような場合）、限られた期間だ
けサーバーからライセンスを「借用」することができます。サーバーに接続した
状態で作業を行う場合は、ライセンスの借用は必要ありません。借用の方法につ
いては ETAS ライセンスマネージャのオンラインヘルプをご参照ください。
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4 お問い合わせ先

製品に関するご質問等は、各地域の ETAS 支社までお問い合わせください。

ETAS 本社

ETAS GmbH

日本支社

イータス株式会社

その他の支社

上記以外の各国支社につきましては、ETAS ホームページをご覧ください。

Borsigstrasse 14 Phone: +49 711 8 96 61-0

70469 Stuttgart Fax: +49 711 8 96 61-105

Germany E-mail: sales@etas.de

WWW: http://www.etas.com/

〒 220-6217 Phone: (045) 222-0900

神奈川県横浜市西区 Fax: (045) 222-0956

みなとみらい 2-3-5 E-mail: sales.jp@etas.com

クイーンズタワー C 17F WWW: http://www.etas.com/

各国支社 WWW: www.etas.com/ja/contact.php

技術サポート WWW: www.etas.com/ja/contact.php
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